Лабораторная работа №8
Блоки в среде AutoCAd. Практическое применение блоков
Цель работы: изучение особенностей построения блоков для создания библиотек элементов деталей необходимых при конструировании сложных механизмов и узлов.

Краткие теоретические сведения
Блоком называется один или группа объектов AutoCAD, которые создаются специ​альной командой, имеют имя для идентификации и обрабатываются как единый объект.
Блоки создаются из стандартных объектов AutoCAD путем их объединения спе​циальной командой. В процессе создания блоков им присваиваются имена, по кото​рым они затем распознаются, и вставляются в рисунок. Можно рекомендовать использовать блоки в следующих целях:
· для создания библиотеки узлов, деталей, типовых решений, часто используе​мых элементов чертежей, которые затем вставляются в новые чертежи;
· для обеспечения быстрого и эффективного создания и редактирования черте​жей путем добавления в чертеж заранее разработанных элементов, изменения отдельных узлов путем переопределения блоков, перемещения и копирования блоков, вместо отдельных геометрических объектов;

· для экономии дискового пространства и уменьшения размера файла чертежа, ускорения обработки сложных чертежей путем адресации всех вхождений од​ного блока к его единственному описанию в базе рисунка;
· для связи графических элементов чертежа с текстовым описанием — атрибута​ми блока, которые могут затем использоваться в различных целях, например, для маркировки объектов на чертеже, для создания спецификаций оборудова​ния или для организации несложных баз данных.
Каждый блок в AutoCAD трактуется как один объект независимо от количества геометрических объектов, из которых он создан. При вставке блока в чертеж он за​писывается в базу AutoCAD как один объект и поэтому занимает значительно мень​ше места. Кроме того, команды редактирования применяются к нему как к одному объекту, поэтому его значительно проще копировать, переносить, поворачивать или отображать зеркально. К объектам блока можно привязываться, используя объектную привязку как к отдельным объектам независимо от того, что они являются элементами блока. Блок также имеет специфическую объектную привязку - точку вставки, которую можно использовать для точного размещения блока на чертеже.
В качестве блока может выступать любой ранее созданный файл чертежа, что позволяет создавать сборочные чертежи, состоящие из узлов, разработанных в отдельных файлах.

Применение в чертежах блоков позволяет быстро изменять отдельные узлы, дета​ли, фрагменты чертежа новым путем переопределения блоков, т. е. создания блока, тем же именем, но с другим набором объектов. Переопределение блоков при умелом и грамотном его использовании — это мощный механизм ускорения и облегчения работы с чертежом.

Применение блоков с атрибутами позволяет связать с графическими объектами определенную текстовую информацию, которая может быть использована для созда​ния точно позиционированных и заранее подготовленных надписей на чертеже или информация для формирования различного рода спецификаций. Кроме того, атри​буты блока можно извлекать из чертежа и использовать для создания текстовых документов, несложных баз данных в виде таблиц Excel или даже полноценно» реляционной СУБД — Access. Данные, полученные из AutoCAD, затем могут обра​батываться этими приложениями так же, как и изначально созданные в них.

При необходимости блок, вставленный в чертеж, можно расчленить на составляющие его элементы, и работать с ними как с обычными объектами.
Создание описания блоков
Под понятием создание описания блока подразумевается определение имени блока, создание выбора объектов, которые должны быть включены в блок, задание базовой точки — опорной точки, относительно которой будет вставляться блок, определение единиц измерения, которые будут использоваться при вставке блока в другой чертеж, и, наконец, ввод текстового пояснения к блоку. 
Текстовое пояснение к блоку — необязательный элемент блока, и его можно не определять. Однако наличие такого пояснения упрощает поиск и работу с блоками.

Кроме этого, при создании описания блока необходимо определиться с тем, что должно произойти с исходными объектами после создания блока. Эти объекты можно оставить в таком состоянии, как они были до формирования блока, удалить из рисунка или автоматически при создании описания блока преобразовать в блок. К блоку можно автоматически создать пиктограмму, по которой его можно распознать в окне Центра управления (Designcenter), предназначенном для вставки блоков из дру​гих чертежей в текущий рисунок.

При создании блока можно определить некоторые элементы поведения блока при его вставке в рисунок. Так, можно изменять режим разрешения или запрета вставки блока с разными масштабами по направлению отдельных осей X, Y или Z, а также включить или отключить опцию, запрещающую расчленение блока после того, как он будет вставлен в рисунок.
Сразу же после создания блока можно открыть окно редактирования динамических  блоков и преобразовать обычный блок в динамический.

Перед созданием описания блока надо выполнить построение всех объектов, ко​торые должны войти в блок. При этом взаимное расположение объектов, их свойства должны быть точно такими, как требуется в блоке.

Для создания описания блока (зачастую это понятие заменяется понятием «со​здание блока») применяется команда Блок (block или bmake), вызвать которую можно одним из следующих способов (см. рис.1):

· панель инструментов Рисование (Draw) рис. 1а 


· меню: Рисование => Блок =>Создать (Draw => Block=>Make) рис. 1б
· командная строка: Блок (block или bmake) рис. 1в
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Рис. 1 – Способы создания блоков в AutoCAD
Вызов данной команды любым из приведенных выше способом приведет к открытию диалогового окна Описание блока (Block Definition), показанного на рис. 2, используя которое можно сформировать блок, присвоить ему имя и сохранить в текущем рисунке.
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Рис 2. – Диалоговое окно «Описание Блока»

:Рассмотрим назначение элементов управления, расположенных в этом окне.
· Поле Имя (Name) предназначено для ввода имени блока. Оно может содержать до 255 русских или английских символов. В составе имени могут содержаться буквы, цифры, пробелы и специальные символы, не используемые Microsoft Windows или AutoCAD в других целях. Имя блока хранится в базе текущего рисунка.
· В зоне Основная точка (Base point) задаются координаты базовой точки вставки блока. Базовой точкой называется точка, которая используется при вставке блока, она обязательно должна определяться для каждого блока. Базовая точка не обязательно должна быть расположена на объекте. Удобнее эту точку располагать таким образом, чтобы относительно ее было просто вставлять блок
По умолчанию базовая точка привязывается к точке с координатами 0,0,0. Однако такое ее положение редко удовлетворяет требованиям пользователя и чаще всего для каж​дого блока ее надо определять индивидуально. В таком случае можно ввести координа​ты базовой точки в соответствующие поля X, Y и Z либо нажать кнопку Указать (Pick point) для выбора этой точки на экране. После щелчка по кнопке Указать (Pick point) AutoCAD временно закроет окно Описание блока (Block Definition) и выведет запрос:
Укажите базовую точку вставки: (Specify insertion base point:).


В ответ на него необходимо любым способом определить координаты точки, ко​торая будет принята в качестве базовой. При этом можно использовать объектную привязку как к тем объектам, которые будут входить в состав блока, так и к любым другим. Сразу же после указания точки AutoCAD вновь возвратит на экран диалого​вое окно Описание блока (Block Definition), в котором в полях X, Y и Z будут выведе​ны координаты точки, выбранной в качестве базовой (см. рис. 2).
В зоне Объекты (Objects) расположена кнопка Выбрать объекты (Select objects), а также опции, определяющие поведение программы по отношению к выбранным объектам после создания блока. Здесь же расположена кнопка Быстрый выбор (QuickSelect), она предназначена для вызова одноименного диа​логового окна, с помощью которого можно быстро выбирать объекты по их свойствам.
Щелчок по кнопке Выбрать объекты (Select objects) приведет к временному закрытию окна Описание блока (Block Definition) для того, чтобы пользователь мог выбрать необходимые объекты в области построения для преобразования их в блок.

В правом верхнем углу диалогового окна «Создание блока» расположены три переключателя:

· Оставить (Retain);
· Сделать блоком (Convert to block); 

· Удалить (Delete). 
Эти переключатели определяют, что произойдет с объектами, выбранными в блок после его создания.


При выборе опции Оставить (Retain) выбранные объекты остаются в рисунке без каких-либо изменений.
Выбор опции Сделать блоком (Convert to block) приведет к тому, что выбранный объекты остаются в рисунке, но уже в виде только что созданного блока, т. е. они перестают быть отдельными объектами.


Если же будет выбрана опция Удалить (Delete), то выбранные объекты удаляются из рисунка, но они тут же могут быть возвращены в него с помощью команды Ой (oops) или вставлены как блок.


Чуть ниже поля переключения режимов располагается поле выбрано объектов (objects selected), в котором выводится информация о количестве выбранных в чертеже объектов, которые войдут в блок.


В правом верхнем углу окна, рядом с полем ввода имени блока, расположена большая графическая область, в которой выводится графический образец создаваемого блока. Это поле появляется только после того, как пользователь произведет выбор объектов в рисунке для образования блока.
В зоне Настройки (Settings) находятся элементы управления, которые определяют поведение блока при его вставке в рисунок.


В поле раскрывающегося списка Единицы вставки (Drag-and-drop units) выбираются линейные единицы измерения, в соответствии с которыми блок масштабируется при вставке его из Центра управления (Designcenter).

В поле Пояснение (Description) можно ввести также необязательные при создании блока данные - текстовое пояснение к описанию блока, которое отображается в зоне вывода описания окна Центр управления (Designcenter) при просмотре базы блоков рисунка.
После выполнения всех операций созданный блок можно сохранить как отдельный файл для последующего использования в построении. Для этого необходимо во вкладке Файл (file) выбрать опцию Сохранить как (Save as). В появившемся окне указать имя файла и выбрать соответствующее расширение файла (Например: Штамп.dwg), после чего указать место сохранения файла и подтвердить выбор нажатием клавиши Enter.

Вставка блоков в рисунок

Для вставки блоков, определенных в чертеже, применяется команда Вставить (insert). Используя эту команду, можно вставить в чертеж как блоки, имеющиеся в текущем рисун​ке, так и блоки, сохраненные в виде отдельных файлов, и даже любые другие файлы черте​жей формата *.dwg. В процессе вставки блока или ранее созданного рисунка, чертежа указываются точка вставки блока, коэффициенты масштабирования и угол поворота.
Блок в чертеж можно также вставить при помощи Центра управления (Designcenter) или из инструментальных палитр. Приемы, которые используются при вставке рисунка коман​дой Вставить (insert) и посредством Центра управления (Designcenter), различны и поэтому будут рассмотрены в отдельности.

Команда Вставить (insert) применяется, в основном, для вставки блоков, описанных в данном чертеже, либо целого рисунка, разработанного ранее. Вызвать эту команду можно одним из следующих способов:
· панель инструментов Рисование (Draw): [image: image3.png]



· меню: Вставка => Блок (Insert => Block)

· командная строка: Вставить (insert).

AutoCAD откроет диалоговое окно Вставка блока (Insert), показанное на рис.3 в котором производится задание блока где определяется положение вставляемого, также масштаб и угол поворота блока при вставке относительно его исходного состояния.
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Рис. 3 – Общий вид диалогового окна «Вставка блока»

Выбор требуемого блока осуществляется в поле раскрывающегося списка Имя (Name) список содержит имена всех блоков, определенных в данном чертеже или ранее вставленных в него из других чертежей, а также имена блоков, которые AutoCAD создает автоматически в процессе выполнения отдельных команд.
Если в качестве блока необходимо вставить блок, ранее сохраненный в виде файла, или любой ранее созданный чертеж, его следует найти на диске. для этого нужно, находясь в диалоговом окне Вставка блока (Insert), нажать кнопку Обзор (Browse), после чего будет открыто диалоговое окно Выбор файла рисунка (Browse  Drawing File) В этом окне следует выбрать файл, который нужно вставить в текущий рисунок в качестве блока и нажать кнопку Открыть (Open). После этого окно Выбор файла рисунка (Browse Drawing File) будет закрыт: в окне Вставка блока (Insert) в поле Путь (Path) будет выведен полный путь к вставляемому блоку.
В зоне Точка размещения (Insertion point) можно выбрать один из двух режимов определения точки вставки — точки, в которую будет помещена точка, определенная при здании описания блока как базовая точка блока. Если выбрать режим Показать экране (Specify On-screen), то точку вставки необходимо будет ввести с помощь устройства указания на экране, либо в диалоговом окне «Вставка блока» указать численные значения координат X, Y и Z точки вставки блока.
В зоне Масштаб (Scale) устанавливается масштаб для вставки блока. Масштаб можно определять одинаковым по всем осям или разным. При вводе разных значений масштабов блок будет растягиваться по оси, для которой введен коэффициент больше 1 и сжиматься по оси с коэффициентом меньше 1. Если какой-либо из масштабных коэффициентов определить в виде отрицательного значения, то блок зеркально отобразится в этом направлении. 
В зоне Угол поворота (Rotation) вводится угол поворота для вставляемого блока. Как и для остальных параметров, могут быть два варианта: указать угол поворота блока с помощью устройства указания на экране (для этого необходимо установить метку в поле Указать на экране (Specify On-screen) или в поле Угол (Angle) задать конкретное значение угла поворота. 

После определения всех указанных ранее параметров для вставки блока в окне Вставка блока (Insert) нужно нажать кнопку ОК. При этом, если установлен флажок Указать на экране (Specify On-screen) в каком-то из полей, AutoCAD запросит ука​зать на экране соответствующие данные.
Атрибуты блока. Создание и редактирование
Атрибутом блока называют текстовую ин​формацию, которая может изменяться при вставке блока в рисунок. С её помощью можно выполнять надписи к блокам, ее можно выводить в отдельный файл для ис​пользования в электронных таблицах, базах данных или как исходный материал для создания различного рода спецификаций.

Для возможности использовать атрибуты блока (block attribute), необходимо вначале специальной командой создать их описание. Описанием атри​бута является текстовый объект, описывающий характеристики и свойства атрибута и имеющий название - Имя атрибута (Tag).

После создания описания атрибута его надо включить в определение блока в ка​честве одного из объектов, входящих в блок. После этого при каждой вставке блока в рисунок AutoCAD будет запрашивать значения атрибута — таким образом, для каж​дого вхождения блока можно определять другое значение атрибута, т. е. вводить но​вый текст. При этом значение атрибута располагается в том месте, где в исходном рисунке было расположено Имя атрибута (Tag).

Большинство команд редактирования объектов воспринимает атрибуты блока и блок как один объект. Например, при перемещении или копировании блока вместе с ним перемещаются или копируются его атрибуты так, как будто бы они являются обычным текстом, включенным в определение блока. Однако имеются специальные команды, ко​торые позволяют редактировать атрибуты отдельно от блока как самостоятельный текст.
С блоком можно связывать несколько атрибутов. Только необходимо, чтобы они имели разные имена. При вставке блоков с несколькими атрибутами значение каж​дого из них запрашивается в отдельности. Есть возможность создавать постоянные атрибуты, которые имеют неизменные значения во всех вхождениях блока и не зап​рашиваются при его вставке.

Атрибуты могут быть невидимыми на экране — так называемые скрытые атрибуты. Однако так как они хранятся в базе рисунка, то их можно, как и видимые, извлекать из рисунка и выводить в отдельный файл для использования другими приложениями.
При вставке блока с атрибутами их значения можно вводить в командной строке (что не всегда удобно) или в специальном диалоговом окне Ввод атрибутов (Enter Attributes), выводом которого управляет системная переменная attdia.

Описание атрибутов
При создании описания атрибутов задаются параметры формирования текста, ко​торый будет запрашиваться при вставке блока с атрибутами в рисунок, и место рас​положения этого текста относительно элементов блока.

Хотя созданию описания атрибутов необязательно должно предшествовать созда​ние графических объектов блока, для которых описываются атрибуты, лучше все же вначале создать эти объекты, а затем переходить к созданию описания атрибутов. В таком случае легче и проще правильно расположить описания атрибутов относительно графических элементов блока. При необходимости создать атрибуты к существую​щему блоку вначале его лучше расчленить, хотя это требование и необязательное.

Для создания описания атрибутов используется команда Атопр (attdef), которая вызывается одним из следующих способов:

· меню: Рисование => Блок=> Задание атрибутов (Draw => Block=>Define Attributes) 
· командная строка: Атопр (attdef). 
После вызова команды AutoCAD откроет диалоговое окно Описание атрибута (Attribute Definition), показанное на рис. 4,  в котором определяется его имя, под​сказка и начальное значение, режимы вставки и отображения атрибута, а также па​раметры, которыми будет выводиться текст, и точка его вставки
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Рис.4 – Общий вид диалогового окна для вставки атрибутов блока

Рассмотрим назначение основных полей управления и опций окна Описание атри​бута (Attribute Definition).

В зоне Режим (Mode) расположены переключатели выбора одного из четырех нео​бязательных режимов отображения атрибутов: Скрытый (Invisible), Постоянный (Constant) Контролируемый (Verify) и Установленный (Preset).

Опция Скрытый (Invisible) устанавливает режим, при котором значение атрибута блока, вставленного в рисунок, не должно отображаться на экране.

Опция Постоянный (Constant) задает режим ввода фиксированных значений ат​рибута для всех вхождений блока. Это значит, что значение постоянного атрибута не будет запрашиваться при вставке блока, а будет выводиться значение по умолчанию, то есть то, которое определено при описании атрибута.

Выбор опции Контролируемый (Verify) устанавливает режим, когда AutoCAD про​веряет значение вводимого атрибута и сравнивает его со значением, принятым по умолчанию. Если эти значения не совпадают, он выдает предупреждение Проверьте значения атрибутов (Verify attribute values). Пользователь может ввести как новое зна​чение, так и значение по умолчанию. Данный режим обрабатывается только при за​дании значений атрибутов в командной строке.

При выборе режима Установленный (Preset) AutoCAD в процессе вставки блока автоматически присваивает атрибуту значение по умолчанию. Однако, если пользователю необходимо изменить его, это можно выполнить после отрисовки блока командой редактирования атрибутов. Данный режим игнорируется при вводе значений атрибутов из диалогового окна, так как основное его назначение — уменьшить количество запросов при задании значений атрибутов, а при использовании диалоговыми окна запросы не выводятся.


В зоне Атрибут (Attribute) задается Имя (Tag), Подсказка (Prompt) и Значение (Value) для атрибута. Каждое из полей этой зоны может содержать до 256 строчных либо прописных русских или английских символов.


В поле Имя (Tag) вводится имя атрибута, которое используется для идентификации каждого вхождения атрибута в рисунок. Поле Имя (Tag) должно быть обязательно определено, т. е. оно является обязательным для заполнения при описании определения атрибута в отличие от остальных двух необязательных полей, расположенных в зоне Атрибут (Attribute).

В поле Подсказка (Prompt) задается текст подсказки, которая выводится при вставке блока в командной строке либо в диалоговом окне. Если при описании атрибута оставить поле Подсказка (Prompt) пустым, то в качестве подсказки AutoCAD будет использовать данные из поля Имя (Tag). При выборе в зоне Режим (Mode) опции Постоянный (Constant) данное поле будет недоступным, так как для постоянных атрибутов подсказка не выводится.

Поле Значение (Value) предназначено для ввода значения атрибута, которой будет использоваться при вставке блока как значение по умолчанию. 

Поля X,Y и Z, расположенные в зоне Точка вставки (Insertion Point), предназначены для ввода численных значений координат точки вставки атрибута, которые определяются в текущей системе координат. Точку вставки можно задать на экране, если установить флажок в поле Указать на экране (Specify On-screen), либо указать числовые значения координат X, Y и Z для вставки блока. 

В зоне Параметры текста (Text Options) задаются выравнивание, текстовый стиль, высота и угол поворота текста атрибута.

В поле раскрывающегося списка Выравнивание (Justification) выбирается порядок выравнивания текста атрибута относительно точки, определенной в поле Точка вставки (Insertion Point). Т. е. параметром Точка вставки (Insertion Point) задается точка встав​ки атрибута в рисунок относительно блока, а параметр Выравнивание (Justification) устанавливает порядок выравнивания текста относительно этой точки.

В поле Текстовый стиль (Text Style) выбирается из текстовых стилей, имеющихся в данном чертеже, один, которым будут отрисовываться символы атрибута.
В поле Высота (Height) указывается высота символов текста атрибута. При этом высо​те можно определить двумя способами. Либо в текстовом поле ввести численное значе​ние высоты символов в единицах измерения, принятых в рисунке, либо нажать кнопку Высота (Height) и после того, как AutoCAD временно закроет окно, указать две точки на экране, расстояние между которыми будет воспринято как высота символов. Если в оп​ределении текстового стиля указана конкретная высота символов либо выбрана опция выравнивания Вписать (Justification), поле ввода высоты текста будет недоступным.
Таким же образом, как высоту текста, можно определить угол поворота текста атри​бута относительно оси X. Это значение также можно либо ввести в поле Поворот (Rotation), либо указать на экране после щелчка по кнопке Поворот (Rotation). 
Упражнение 1
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выполнить чертеж детали представленной на рисунке 5
1. Создайте блок с помощью команды Создать блок (Make block). 
2. В появившемся окне щелкнув по пиктограмме Указать точку вставки (Pick point) выберите с помощью объектной привязки любую точку на чертеже. 
3. После чего в поле Имя введите текст «Высотная отметка».
4. Щелкнув по пиктограмме «Выбрать объекты» выберите все объекты на вашем чертеже для формирования блока

5. Установите метку напротив поля Сделать блоком (Convert Block)
6. В качестве единиц измерения установите «Миллиметры».

7. После задания нажмите ОК или клавишу Enter.

8. Сохраните полученный блок на жестком диске с расширением dwg.

Упражнение 2.

Создайте в AutoCad новый документ.  С помощью команды Вcтавить блок (Insert block) выберите на жестком диске файл построенного ранее блока. После чего в появившемся диалоговом окне самостоятельно:

1. рассмотрите два режима вставки блока;

2. постройте изображения блока изменяя масштаб изображения;

3. постройте зеркальное изображение блока относительно оси X,Y и относительно двух осей XY
4. постройте повернутое изображение блока под углами 30, 45 и 90 градусов относительно оси X.
Упражнение 3

Самостоятельно создайте штамп рамки (ГОСТ 2.104-68*) представленном на рис. 6  в виде блока.
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С помощью вкладки Задание атрибутов (Define Attributes) создайте атрибуты блоков указанных на рисунке. 
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